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Introduction

FV2200 version 2 introduces two major new features: the option to apply a model (Kobayashi et 

al.1) to correct for scattering errors in LAI measurements, and support for GPS records from the 
LAI-2200C. 

The scattering corrections involve some important new recommendations for how to take mea-
surements with LAI-2x00 instrumentation. These recommendations are laid out in the operating 
manual of the LAI-2200C, and are summarized at the end of this document (Appendix A: Scatter-
ing Corrections on page 35).

Throughout this document, the generic model number designation LAI-2x00 refers to any of the 
LAI-2000, LAI-2200, or LAI-2200C instruments. If material is specific to any one of those, then 
that specific model number is used.

1. Kobayashi H., Y. Ryu, D.B. Baldocchi,J.M.Welles, J.M.Norman. 2013. On the correct estimation of gap 
fraction: How to remove scattered radiation in gap fraction measurements? Ag. and For. Meteorology, 
174-175: 170-183
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Quick Reference

Acquire - Read files from an LAI-2000 or LAI-2200 via RS-232 (1.1 Loading Data Files into 
FV2200 on page 4).

Add Chart - 3.1 Charts on page 25.
Combine - 2.5 Combine Multiple Files (FV2200) on page 21.
Cut - Removes selected files from current view, adds to file clipboard.
Copy - Copies selected files from current view, adds to file clipboard.
Delete - Removes selected files from current view.
Display - 1.3 Change the Displayed Variables on page 6.
Expand - Split an LAI file into pieces (2.6 View LAI for each B record on page 22).
Export - 3.3 Spreadsheet Export on page 33.
Import - 2.3 Import and Adjust A Records on page 15.
Map - 3.2 GPS Maps on page 28.
New - Create a new, empty view.
Open - 1.1 Loading Data Files into FV2200 on page 4.
Paste - Copies files in file clipboard (see Copy, Cut), and adds them to the current view.
Prompts - 2.7 Edit Prompts and Remarks on page 22.
Recompute - 2.0 Recomputing Files on page 14.
saveAs - 1.2 Saving files in a view on page 5.
Scattering - 2.4 Scattering Corrections on page 17.
Statistics - 3.4 Summary Statistics on page 34
Strip - 2.8 Strip Records on page 23
Transform - 2.9 Transform Records on page 24.
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1.0 Basic Operations

1.1 Loading Data Files into FV2200
LAI files can be read directly from an LAI-2200 or LAI-2200C when it is attached to the com-
puter via USB. Click the Open tool button (or File > OPEN) 

When reading files from disk, if more than one is selected, you are prompted with

Data can also be read via RS-232 from LAI-2000 and LAI-2200 consoles. Click the Acquire tool 
button (or File > Acquire) to open the Acquire Wizard, and follow the steps.

The LAI-2200 shows up as an external 
drive named LAI. The data files are in 
the folder named DATA.
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1.2 Saving files in a view
All of the files in a view can be saved by File > saveAs, or by clicking the saveAs button. Usually, 
each file retains its format (LAI-2200 or LAI-2000), but this can be overridden (see below). 

Another (perhaps better) method of converting a file from LAI-2000 to LAI-2200 format is given 
in 2.10 Convert LAI-2000 to LAI-2200 on page 24, which allows you to specify sensor serial 
numbers.

There is probably no good reason to convert an LAI-2200 format to LAI-2000, as much ancillary 
data (scattering corrections, GPS information, etc.) will be in the old format.

You can explicitly specify the format 
to be used when saving files.
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1.3 Change the Displayed Variables
Click the Display tool icon (or View > Display) and bring up the Display dialog. 

List of items displayed in the 
main view. Items can be added 
to the list by drag and drop from 
the left side.

The list is sortable (click and 
drag). Items can be removed by 
selecting them and using the 
trash button. The list can be 
saved and read from disk. 

The list of all viewable items is 
divided into three categories:
Header - single-value items in 
an LAI file’s header.
Rings - Ring summary items 
from the file’s header.
Recs - Items from the raw 
data records.

With Ring items, you can spec-
ify which ring(s) you want to 
view. For each box checked, an 
separate entry is created in the 
display list. For example, drag-
ging over Gaps results in 
GAPS[1] through GAPS[5] 
when all the rings are checked.

For any Recs item, specify the 
transformation you wish per-
formed to make that value a sin-
gle item that can be displayed. 
Some Recs items are 5-value 
ring items, and these let you 
specify which ring(s) to display. 
Each ring becomes a separate 
entry.

For example, dragging over Raw 
with one ring checked and the 
transform set to Mean results in 
Mean(RawA[1]).

Drag Drop

Figure 1: The dialog used to pick which variables to display in a view. It is also used to pick variables to export 
in spreadsheet format or picking the set to get statistics.
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1.4 Sorting the Displayed Variables
The order in which files are displayed in a view can be sorted by right-clicking in a view and 
enabling Allow Sorting. When sorting is enabled, just click a column heading to sort the files by 
order of items in that column. Click the column again to reverse the sort order.

1.5 Viewing File Details
Double click a file entry to bring up the File Details window.

Right-click in a view to enable/disable sorting
With sorting enabled, click a column header

Double Click

As Read: A read-only text of the file as it was read from disk or the instrument.
Current: An editable text view of the current state of the file (1.5.1 Current on page 8).
Gap Fractions: View the details of a file at each B reading, including LAI (1.5.2 Gap Fractions on page 8).
All Values: Shows all possible computed values.
Header: GUI for changes (1.5.3 Header on page 9).
Sky Test: A tool for quantifying the effect of sky conditions in terms of LAI uncertainty. (1.5.4 Sky Test on page 10).
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1.5.1 Current
The Current tab shows an editable text view of the current state of an LAI file.

1.5.2 Gap Fractions
The Gap Fractions tab shows the LAI and Gap Fractions for each B record that was used in the 
LAI calculation (Figure 2). If a file is scatter corrected, there is more information on each line: the 
pre-correction gap fraction, and the K record information that is associated with each B reading 
(Figure 3 on page 9).

If you make editing changes, these 
button become active.
Keep - keep your changes.
Cancel - abandon your changes.

Save this as a text file

To copy-paste into a 
spreadsheet, use this 
button for the copy 
part of the task.

Figure 2: The Gaps Fractions tab shows LAI and gap fractions for each B reading in a file.
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1.5.3 Header
The Header tab provides a graphical summary of the header information in a file.

Pre-correction gap fractions.
K Record info.

Figure 3: The Gap Fractions view for a file with scattering corrections.

Scatter Inputs dialog, see Figure 11 on page 21 2.0 Recomputing Files on page 14

Plot any of the ring 
summary items 
simply by clicking 
in the row.
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1.5.4 Sky Test
The Sky Test tab in the Details Window (Figure 4 on page 11) provides a tool to quantify the vari-
ability of the sky conditions in terms of uncertainty in the LAI that would exists if you were mak-
ing LAI measurements then. You can use the Sky Test analysis to measure sky stability (with 
time), or to get an indicator of sky uniformity (consistency with direction of view). 

You can apply this test to the A readings in a normal file, or in an above file, to see the potential 
sky-induced variability for the sky conditions you had. 

The analysis consists of using the first A record (or whatever record type you choose) as the stan-
dard, then compare subsequent A records to it. Gap fractions are computed for each ring for each 
pair. If there is no change from one to the next, all the gap fractions would be 1.0, and the LAI is 
0. If there is a change in one or more rings, then LAI increases. (Note: for this analysis gap frac-
tion is always computed such that it is < 1. That is, gap fraction for a ring is the “below” value 
divided by the “above” value. If that turns out to be > 1, we simply invert it so it is < 1.)

The analysis either runs through the whole file comparing all records to the first, or whenever the 
time difference exceeds some limit set by you, that record becomes the new reference. Figure 4 
indicates that for a clear blue day, gaps in time between reference readings and below canopy 
readings up to 300 seconds will result in an LAI uncertainty of only 0.01. With a 30 second differ-
ence, the uncertainty drops to 0.001. Clearly, blue skies are nice for stability.



FV2200 2.0 User Guide

11 / 54

Some other sky types are shown in the figures below.

Figure 4: Sky test applied to data collected near noon on a clear blue day. The Max 
Delta, if checked (left) means the reference reading shifts periodically so the time 
differences stay within the limit you specify (300 secs in this case). If unchecked 
(right), the reference reading for the entire file remains the first record.
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Figure 5: A heavy, non uniform overcast moving quickly with the wind is a 
tough sky to work with. Even with only 10 seconds between A and B read-
ings, you can still have LAI uncertainties of up to 0.1. If you let that time 
stretch out to 60 secs, the uncertainty can get up to 0.5 in some of the cases 
captured here

Figure 6: A twenty minute period of broken to scattered cumulus on a fairly 
windy day. This is also a difficult sky to work with. Time differences between A 
and B readings need to be kept as short as possible.

Figure 7: Thirty minutes under cirrus clouds. This is a fairly easy sky to work 
with, as LAI uncertainties are well under 0.1 even for 5 minutes time intervals. 
For under one minute, the uncertainty is 10 times lower.
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You can also use the Sky Test to measure the penalty for not having above and below readings 
exactly aligned (Figure 8 on page 13). Open a file and log about 10 or 12 readings in the general 
direction of interest. For example, if you are using a 45 degree view cap and intend to make LAI 
measurements aimed to the North, then make those readings between NW and NE; use whatever 
azimuth range you think can be easily maintained during a measurement session, bearing in mind 
that in a tall canopy, you may not keep your bearings quite as well as you might hope, and the 
below readings may have a wider range of direction than you think.

 

Stability With Direction Stability With Time

Figure 8: A fairly uniform overcast. The data plotted on the left were collected over 1 minute, with the wand 
aimed in a variety of directions +/- 45° of the target direction. View cap was also 45°. This gives an indication 
of directional uniformity. The data plotted to the right is about 20 minutes of data collected with the wand 
fixed on a tripod.
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2.0 Recomputing Files

Recomputing a file usually happens automatically as needed, such as after importing A records, or 
adding scattering corrections. There are times, however, when you might need to remove a ring, or 
change how transmittance is computed, and for those you can use the Recompute Dialog. This is 
available by clicking the Recompute tool (or Edit > Recompute). The dialog is also accessible 
for a single file from the Header tab of the Details view (1.5.3 Header on page 9).

2.1 Exclude Rings from Analysis
You can use the Change Mask in the Recompute Dialog, or edit the file directly in the Details 
Window (1.5.1 Current on page 8).

Exclude rings

Specify canopy geometry

How to compute 
transmittance

In Recompute Dialog. In Details Window
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2.2 Interpolate A Records
You can use the Recompute Dialog. For a single file, you can use the Detail View, Header tab, or 
Current tab.

2.3 Import and Adjust A Records
When one sensor collects B records, and another sensor collects A records, that data needs to be 
put together. Unless the sensors were matched prior to collecting data, an adjustment needs to be 
made to one of the data sets. The discussion of this is in Appendix B. Three Methods for FV2200 
Matching on page 47. 

Once you’ve collected the data, merging and adjusting is quite simple. Follow the steps below. If 
you wish to try this with same sample data, open one of the built-in sample files found in File > 
Samples (pick Import_Match_Method1), then go to step 3.

1. Open the above and below files. You may elect to put them into one view.
2. If the data was collected with Match Method 1 or 2, load in the associated Match files.
3. Click the Import tool button to open the Import Records Dialog.

In Recompute Dialog. In Details Window

Set the middle value 
to ‘i’ for interpolation.

c
a
b

p
i
c

s
c

The three groups refer to the three groups in the 
Recompute Transmittance. The options for each 
group are shown here.
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4. Click the OK button to perform the import (and adjustment, if that box is checked). Sample 
results for the example above are shown below:

Interpolate match records. One of the options for Methods 2 and 3 is to interpolate the adjust-
ment factors over time. This is normally not necessary or recommended, unless a) you have good 
match data (i.e. viewing clear, blue sky) at the start and end of your measurements, and b) some-
thing happened during the measurements that would lead you be believe this is necessary, such as 
dust accumulation on the above sensor lens. Note: this is NOT the same as interpolating A 
records; this is interpolating the adjustment factors for modifying those records as they are 
imported.

Match Method 1 Example.
The source file contains 86 A records 
made by sensor PCH-3006. We have 
two destination files, each with only B 
records, made with two different sen-
sors, PCH-3002 and PCH-3004. The 
match file, made on an earlier day, con-
tains 6 A records: two each for the three 
sensors.
In this case, we need this box checked. 
Otherwise, we would have multiple sen-
sors in our destination files, and would 
not be able to compute a single adjust-
ment factor per ring. Note: there is a 
warning displayed when this is the case:

You can preview what the adjustment factors will be for each ring by 
clicking Preview this.... When computing them for each individual file, 
as we are here, you can select which file that information is for.

Method 1 Example Results 
Closest in time A records have been 
imported. The imported records are from 
sensor PCH-3006, and are labelled W2 in 
the records. 
The adjustment factors that the W2 rings 
were multiplied by as they were imported 
are shown here.
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Examples for using Match Methods 2 and 3, and a combination of the two, are shown in 
Figure 27 on page 50, Figure 28 on page 51, and Figure 29 on page 52.

2.4 Scattering Corrections
The scattering corrections are discussed in Appendix A: Scattering Corrections on page 35.

LAI-2000 Note: Applying scattering corrections to a file in LAI-2000 format will automatically 
change its format to LAI-2200 format. If you wish to include some sensor information in the new 
format, you might wish to convert the file yourself (2.10 Convert LAI-2000 to LAI-2200 on 
page 24) prior to adding scattering corrections.

2.4.1 Generate K records from Sequences
The data for a K record is usually in the form of a 4A sequence, but other patterns are possible 
(Other Ways to Make K records on page 40). To convert such sequences to a K record, do the fol-
lowing:

1. Load the file into FV2200.
2. Click the Scattering tool icon (or Edit > Scattering).

Normally, you only check 1 pattern (AAAA, AAA, etc.) per file. You can get away with mixing 
certain patterns, however, such as AAAA and AAA, or BBBA and BBA provided the sequences 
do not run together. In other words, 4A or 3A sequences surrounded by B records would be fine, 
or 3B or 2B records surrounded by A records would be fine. (You would not want to mix A 
sequences with B sequences, however). The order that FV2200 converts records in a file (if doing 
more than one sequence in the file) is this: 4A, then 3A, then 3BA, then 2BA. So, if you have 4A 
and 3A together, the 4As will be done first, before the 3As.

3. Click K Records

4. Select Make K from 
Sequence

5. Enter ancillary information.

6. Check the files according to 
the input sequence(s) in the file.

Check boxes will appear for all pos-
sible patterns in the file. In this case, 
there are no BBBA or BBA patterns 
found, so no boxes for them.

7. Click the Make K Records... button.



FV2200 2.0 User Guide

18 / 54

If you do check more than one pattern for a file, you will see a warning. It won’t stop you, it’s just 
a check to see if you know what you are doing.

2.4.2 Generate K Records from assumptions
Sky inputs for scattering corrections can be generated for old files using some assumptions and 
the measured A records. If the sun was obscured, you know the fraction beam was 0. If it was a 
clear blue day with the sun not obscured, you can opt for the software to guess at a reasonable 
fraction of beam value for you. 

If you select this option, Fbeam will be 
estimated (roughly) from the solar zenith 

angle using fbeam 0.9 θscos=

3A and BBA patterns don’t need this, since it is 
assumed the ‘A’ reading is also being used for the 
wide sky reading.
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2.4.3 Import K records
If you have K records, but not in the right file, or need to share K records among multiple files, 
then use the Import K Records option of the Scattering Tool. 

2.4.4 Setting Scattering Inputs for a group of files
The Clipboard tab of the Scattering Input tool is designed to set inputs for a range of files, rather 
than just one file (2.4.5 Enter or Edit all inputs for one file on page 19). 

2.4.5 Enter or Edit all inputs for one file
Usually the sky inputs for the scattering corrections are done with K records (K Records on 
page 39), but this can be bypassed and done entirely in one dialog. The Scattering Input Dialog is 
accessible via the Scattering Tool (Edit > Scattering) as shown in Figure 10 on page 20. A file in 
the main view must be selected.

Source - files that have K records.
Dest - files that need K records.

In the Main View, select the 
file(s) you want to apply these 
inputs to. Then click this button.

If a file has K records, this 
section is ignored, even if 
checked.

If a file has G records (GPS 
info), this section is ignored, 
even if checked.

Figure 9: The Clipboard tab of the Scattering Correction Input tool.
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If the file has scattering inputs, the relevant part of the file header with those inputs is shown in an 
editable text box. 

Figure 10: Select File tab of the Scattering Tool.

Set the clipboard (Figure 9 on 
page 19) using these values. View the Scattering Input Dialog (Figure 11 on page 21).

File with scattering corrections File without scattering corrections

See Figure 21 on page 37 for information on editing scat-
tering inputs in a file header.
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A dialog box for entering or viewing all the scattering inputs for a file is shown below. 

2.5 Combine Multiple Files (FV2200)
The Combine Files dialog (File > Combine) lets you pick a selection of files for which all of the 
data records are to be combined. The file header information of the resulting file will be based on 
the first file’s headers in the source list.

If you need a more customized method to combine files, there is always cutting and pasting from 
the Detail View. The thing to watch if you do that, however, is the Contributing Sensor informa-
tion and the Sensor ID values of each record. The Combine Files automated routine takes care 
relating sensor IDs (W1, W2, etc.) to the proper sensor in a new list. For example, if one file has 
one Contributing Sensor, say serial # 1234, and another file has a different one (#4321), if you 

Solar angles can be 
entered directly, or 
you can compute 
them from latitude 
and longitude.

Figure 11: The Scattering Inputs dialog can be used to view the inputs for a file that has them, or to add all the 
inputs to a file that needs them. If you use K records, you can avoid entering information with this dialog.

If the sloped terrain method was used (Working on Slopes on 
page 53), then specify the parameters here to make the solar 
angle relative to the terrain. Direction of slope is the direction 
that if faces.
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combine by cut-and-pasting records, all files will have sensor ID’s of W1, and differences will be 
lost. The automated Combine, however, will leave you with W1 and W2 records, with both sen-
sors appearing in the Contributing Sensor list labelled appropriately as W1 and W2. 

2.6 View LAI for each B record 
The simplest method is simply double click the file and view the Gap Fractions tab in the Details 
Window (Figure 2 on page 8). 

The harder method (before version 2.0, it was the only method) is to click the Expand dialog icon 
(File > Expand). This will let you generate a lot of files from one file. You have the option to 
change the transmittance computation method for all the files, as well. 

2.7 Edit Prompts and Remarks
For a single file, this is most easily done using the Detail Window for a file: 1.5.1 Current on 
page 8.
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For a group of files, this can be done all at once using the Prompts and Responses Dialog (Edit > 
Prompts). 

2.8 Strip Records
Records can be stripped from an individual file by editing them in the Details window 
(1.5.1 Current on page 8).

For a range of files, use the Strip Records dialog (Edit > Records > Strip)

Select the file whose prompts and 
responses are used to fill this dialog.

Check the items to be set in 
the destination files.

Records can be identified by type (A, B, etc.) 
or - for LAI-2200 format - by the sensor that 
made the record. This box will list all types of 
records found in the files in the view.

Records can also be removed based on time 
stamp.
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2.9 Transform Records
Records can be mathematically transformed using the Transform Dialog (Edit > Records > 
Transform).

You will probably never have occasion to use this dialog; it was introduced early on to apply after-
the-fact calibrations to sensors. Now that importing and adjusting has become one step 
(2.3 Import and Adjust A Records on page 15), this dialog may be obsolete, but it is here if you 
need it. 

2.10 Convert LAI-2000 to LAI-2200
There are a couple of ways to do this. To convert a single file, you can use the Current tab of the 
Details Window (Figure 12 on page 24). The advantage of this method is that you have an oppor-
tunity to specify sensor serial numbers, which are useful when doing importing and adjusting 
records (2.3 Import and Adjust A Records on page 15).

Another method of converting formats is when saving a view (1.2 Saving files in a view on 
page 5).

Select the mathe-
matical transform.

Select the record type to be 
transformed. The list will show 
the wand and light sensor 
records it found. They can be 
selected by sensor ID, or by type.

When you convert formats, you have an 
opportunity to specify the year (not 
included in the clock of an LAI-2000), and 
also the instrument serial numbers of A, B, 
1, and 2 records. 

If you leave a field blank, or uncheck the 
Contributing Sensors box, then the con-
verted file will not contain a Contributing 
Sensors section.

Figure 12: Converting LAI-2000 to LAI-2200 in the Details view.
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3.0  Viewing Data

3.1 Charts
Click the Add Chart button (or View > Add Chart) to bring up the Chart Setup dialog. 

Raw records variables
(Typically use 40 RawTime[] 
for the x variable)

Ring summary variables
(Typically use 80 Angles[] for 
the x variable)

Right click a chart to 
bring up the context 
options.

To edit an existing chart, 
either double click it, or 
else pick the Edit... 
entry from the context 
menu.
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Charts can be made to plot data from the currently selected file(s), and update whenever the selec-
tion changes. This makes it very simple to step through a long list of files examining some rela-
tionship for each. 

When Auto update is selected, changing 
the selected file(s) in a view will change 
the plot.
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The raws records are usually plotted as time series plots. 

If files have G records, you can make a chart of the measurement track by plotting latitude vs. lon-
gitude. A better way to plot GPS data is 3.2 GPS Maps on page 28, however.

Grouped by Ring Grouped by File
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3.2 GPS Maps
FV2200’s Map tool (File > Maps) (Figures 13) provides a mechanism for exporting a .kml file for 
Google Earth. 

Figure 13: Markers at A and B for three files. The numbers are the record number for the G records associ-
ated with the A or B readings. The LAI profile (turned off here) is shown in the next figure.
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Figure 14 illustrates some of the default marker styles available. Any can be modified, however.

Figure 14: Some of the default marker options with FV2200.
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Figures 15 through 20 illustrate how to edit a marker, or add a new one. 

The marker edit dialog is shown in Figure 16. 

Add new marker, or
edit existing marker
(Figure 16 on page 30)

Remove selected marker

Figure 15: the KML export dialog.

Figure 16: The marker idem dialog is presented when adding a new marker, or editing an existing one.
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Figure 17: Column marker example.

Location is the average of all G records in the file.

Height is 30 times the value of LAI.

Figure 18: The B marker example.

Color comes from the icon’s default, 
and this.

Location is the average of G0 records 
logged with B records.
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G 1 20130822 11:34:33 G1 40.856701 -96.658795 354 6 1.6 20130822 16:37:02

G 2 20130822 11:35:30 G1 40.856308 -96.658751 353.4 7 1.1 20130822 16:37:59

G 3 20130822 11:35:52 G1 40.856322 -96.658491 353.5 6 1.5 20130822 16:38:21

G 4 20130822 11:36:39 G1 40.856413 -96.657747 360.3 7 1.1 20130822 16:39:08

G 5 20130822 11:36:59 G2 40.856237 -96.657657 354.3 7 1.1 20130822 16:39:27

G 6 20130822 11:37:18 G2 40.856038 -96.657624 357.7 7 1.23 20130822 16:39:47

G 7 20130822 11:37:40 G2 40.855781 -96.657705 345.7 7 1.23 20130822 16:40:09

G 8 20130822 11:38:09 G2 40.85559 -96.658067 354.6 7 1.23 20130822 16:40:38

G 9 20130822 11:38:19 G2 40.855626 -96.658261 355.3 7 1.23 20130822 16:40:48

G 10 20130822 11:38:49 G2 40.855933 -96.658471 352.1 7 1.24 20130822 16:41:18

G 11 20130822 11:39:38 G2 40.856219 -96.657822 364.3 7 1.08 20130822 16:42:07

G 12 20130822 11:40:00 G3 40.856119 -96.657425 360.5 7 1.09 20130822 16:42:29

G 13 20130822 11:40:25 G3 40.856037 -96.656957 362.5 7 1.09 20130822 16:42:54

G 14 20130822 11:40:38 G4 40.85593 -96.657023 359.7 7 1.09 20130822 16:43:07

G 15 20130822 11:40:51 G4 40.855783 -96.657 354.8 7 1.09 20130822 16:43:20

G 16 20130822 11:41:22 G4 40.855823 -96.656467 344.4 7 1.09 20130822 16:43:52

G 17 20130822 11:41:35 G4 40.855935 -96.656506 339.6 7 1.09 20130822 16:44:04

G 18 20130822 11:42:07 G3 40.856024 -96.656713 342.9 7 1.09 20130822 16:44:36

G 19 20130822 11:42:25 G3 40.856191 -96.656709 347.4 7 1.09 20130822 16:44:55

G 20 20130822 11:42:36 G5 40.856197 -96.656552 369.4 7 1.09 20130822 16:45:05

G 21 20130822 11:42:52 G5 40.856043 -96.656528 367.2 7 1.09 20130822 16:45:22

G 22 20130822 11:43:02 G5 40.856041 -96.656428 371.6 6 1.15 20130822 16:45:31

G 23 20130822 11:43:18 G5 40.856203 -96.65646 352.6 7 1.1 20130822 16:45:47

G 24 20130822 11:43:23 G3 40.856216 -96.656368 355.6 7 1.1 20130822 16:45:53

G 25 20130822 11:43:54 G6 40.85596 -96.656008 352.5 7 1.1 20130822 16:46:23

G 26 20130822 11:44:10 G6 40.855763 -96.655986 349.3 7 1.1 20130822 16:46:39

G 27 20130822 11:44:27 G6 40.855754 -96.65574 348.6 7 1.1 20130822 16:46:55

G 28 20130822 11:44:43 G6 40.855934 -96.655706 349.1 8 1.05 20130822 16:47:11

G 29 20130822 11:45:09 G3 40.85623 -96.655722 350.4 8 1.05 20130822 16:47:37

G 30 20130822 11:45:57 G7 40.856191 -96.654914 350.9 8 1.05 20130822 16:48:25

G 31 20130822 11:46:16 G7 40.856069 -96.654627 350.9 8 1.05 20130822 16:48:45

G 32 20130822 11:46:32 G7 40.856179 -96.654419 348.9 8 1.05 20130822 16:49:01

G 33 20130822 11:46:49 G7 40.85632 -96.654571 349.8 8 1.06 20130822 16:49:17

G 34 20130822 11:47:55 G3 40.856642 -96.655653 352 8 1.06 20130822 16:50:23

G 35 20130822 11:49:21 G3 40.856608 -96.657093 350.1 8 1.06 20130822 16:51:50

G 36 20130822 11:49:46 G8 40.856831 -96.657164 348.1 8 1.07 20130822 16:52:15

G 37 20130822 11:49:52 G8 40.856828 -96.657134 349.3 8 1.07 20130822 16:52:21

G 38 20130822 11:49:59 G8 40.85686 -96.657052 355.1 8 1.07 20130822 16:52:27

G 39 20130822 11:50:22 G8 40.857026 -96.656997 348.5 8 1.07 20130822 16:52:51

G 40 20130822 11:50:42 G8 40.857095 -96.657277 351.9 8 1.07 20130822 16:53:11

G 41 20130822 11:50:56 G8 40.857008 -96.657357 359 8 1.07 20130822 16:53:25

G 42 20130822 11:51:48 G1 40.856449 -96.657573 354 8 1.07 20130822 16:54:17

G 43 20130822 11:52:15 G1 40.856749 -96.65758 364.7 8 1.08 20130822 16:54:44

G 44 20130822 11:52:35 G1 40.856983 -96.657546 364.7 7 1.57 20130822 16:55:04

G 45 20130822 11:53:35 G1 40.857103 -96.65855 342.5 8 1.08 20130822 16:56:04

G 46 20130822 11:54:01 G1 40.856825 -96.658784 350.5 8 1.08 20130822 16:56:30

Figure 19: Illustration of plotting G records with differing IDs. This file (data shown in background) is data 
obtained on a walk around the LI-COR campus. Each building or area was marked by logging with a numeric key 
instead of the Log key. When plotted as a path (top), you see the walk progress. When plotted as polygons, we get 8 
independent entities on the map. 
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3.3 Spreadsheet Export
You can export data in spreadsheet format by File > Export. 

Figure 20: Marker configurations used in Figure 19. Note the use of the Combine multiple data sets check box.

This button will let you define a list of 
variables to export, using a dialog just 
like Figure 1 on page 6.To copy-paste into a 

spreadsheet, use this 
button for the copy 
part of the task.
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3.4 Summary Statistics
Summary statistics for some or all files in a view is available by View > Statistics.

This button will let you define a list of 
variables for which statistics are 
desired, using a dialog just like 
Figure 1 on page 6.To copy-paste into a 

spreadsheet, use this 
button for the copy 
part of the task.
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Appendix A: Scattering Corrections

One of the traditional underlying assumptions of the LAI-2x00 has always been that foliage 
absorbs all the radiation in the waveband seen by the sensor (320-490 nm). Starting with version 
2.0, FV2200 allows this assumption to be set aside, and provides a model (Kobayashi et al, 2013) 
for correcting measurements for the radiation reflected and transmitted by the foliage. You should 
apply this correction for data taken in direct sun, since that’s when the scattering errors are the 
highest, but you can also correct data taken when the sun is obscured, adjusting for the actual foli-
age scattering properties in your canopy, rather that assuming reflectance and transmittance are 
both 0.

How It Works

The algorithm that FV2200 uses for correcting for scattering goes something like this: 

1. Compute gap fractions
From the measured gap fractions, calculate a first guess of leaf area index (LAI) and leaf angle 
distribution (LAD).

2. Predict the scattering effect on gap fractions
Run the Kobayashi model to predict the error that an LAI-2200 would make in a canopy based on 
LAI, LAD, and the other scattering correction inputs (leaf properties, sky brightness distribution, 
etc.). The model is a one-dimensional, multi-layer model, having foliage properties that you have 
specified. Foliage orientation, clumping, and total LAI is based on Step 1. 

The model propagates beam and diffuse radiation through the layers, and predicts fractional irra-
diances on sunlit and shaded leaves in each layer. It then predicts the view that the LAI sensor, and 
the bottom of the canopy, has of the sunlit and shaded foliage throughout the model, and the 
resulting radiation errors each ring of a B reading would have. 

3. Subtract the scattering effect from gap fractions. 
The gap fractions are then adjusted to remove the predicted scattering effects.

4. Compute new LAI and LAD. Quit, or go to Step 2.
The adjusted gap fractions are used to compute a new LAI and LAD. If they have not changed, the 
process is done. Otherwise, it’s back to step 2 with the adjusted gap fractions.

This process usually takes 4 or 5 iterations.

The ScattCorr Variable
All computed values in FV2200 (LAI, MTA, Gaps, etc.) reflect the effects of the scattering correc-
tion if is enabled. Thus, there are no duplicate sets of values (i.e. no LAI_with_scattering, 
LAI_without_scattering, etc.). There is one quantity (ScattCorr) that tells you the status of scat-
tering corrections for any file (Table 1). When ScatterCorr = a numeric value, all values associ-
ated with that file reflect the effects of the scattering correction. While it is very simple (once the 
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inputs are in place) to turn the correction on and off and examine how any particular value 
changes, the ScattCorr value directly gives you this difference for the LAI value.

ScattCorr is a quantity you’ll want displayed (1.3 Change the Displayed Variables on page 6).

Note: the numeric value of ScattCorr is the difference in LAI as measured by the EllipLAI vari-
able, not the normal LAI variable. The reason is that the scattering correction model uses the 

inversion scheme of Norman and Campbell (1989)1, which is based on an ellipsoidal representa-
tion of leaf angle distribution. This scheme is also built in to FV2200, and the leaf area index 
parameter and leaf angle parameter are available as EllipLAI, and EllipX. The two LAI values 
(LAI and EllipLAI) are generally fairly close.

Required Inputs for the Scattering Model

To correct a measurement for scattering, a model is used that requires some extra inputs, which 
are summarized in Table 2.

Table 1: The ScattCorr variable

Value Meaning

none The file does not have the necessary inputs to be scatter corrected.

off Scattering inputs present, but correction is turned off.

value The file is scatter corrected, and value is the difference in LAI that the 
correction makes. 

1. Norman, J.M., Campbell, G.S. 1989. Canopy Structure.In:Pearcy, R.W., Ehleringer, J., Mooney, H.A., 
Rundel, P. (Eds.), Plant Physiological Ecology. Chapman and Hall, London, pp. 301-325.

Table 2: Required Inputs for the scattering correction

Item Description

LeafRho Average foliage reflectance in the blue (230-490 nm waveband).

LeafTau Average foliage transmittance in the blue.

SoilRho Surface reflectance beneath the canopy in the blue.

SolarZen Solar zenith angle (0° = overhead, 90° = on horizon).

SolarAzm Solar azimuth angle (0° = North, 90° = East, etc.)

SkyViewCap The azimuthal view size of WideSky values (e.g. 270°)

AViewCap The azimuthal view size of ASky values (e.g. 45°)

AViewAzm The azimuthal direction of ASky values (0° = N, 90° = East, etc.)
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Figure 21 shows the additions to the file header when scattering corrections and/or GPS data are 
present in a file. 

ScattCorr indicates the state of scattering corrections, and its values are explained in Table 1 on 
page 36.

The three values for average vegetative reflectance, transmittance, and the surface beneath the 
canopy (LeafRho, LeafTau, and SoilRho) should be for the 320-490 nm waveband. The values 
could come from spectroradiometric measurements integrated over this wave band, or from a 
radiometer sensitive in that wave band. Kobayashi et. al. present a technique for using the 
LAI-2x00 wand and a reference panel to determine these values.

The location information (GpsLat, GpsLong, and TimeZone) will be present only for units that do 
not have G records. GpsLat is degrees latitude (North > 0, South < 0), GpsLong is degrees longi-
tude (East > 0, West < 0). TimeZone is the difference in hours between UTC and the time used in 
the LAI file’s header. If the instrument’s clock was set to local standard time, TimeZone would 
likely be longitude/15. Note that for negative (west) longitudes, the TimeZone is also negative. If 
the instrument’s clock was set to UTC, then TimeZone would be 0.

The solar position values SolarZen and SolarAzm represent the zenith (0=overhead, 90=horizon) 
and azimuth (0=North, 90=East, etc.) angles of the direction toward the sun. These angles are 

FBeam The fraction of the total incident radiation from the sky that is direct 
beam, in the blue.

WideSky The 5 ring values read by the sensor using the SkyViewCap

ASky The 5 ring values read by the sensor using the ASky Cap.

Table 2: Required Inputs for the scattering correction

Item Description

### Scatter Correction 

ScattCorr 0.095

LeafRho 0.050

LeafTau 0.010

SoilRho 0.050

SolarZen 51.1

SolarAzm 94.

TimeZone -5

GpsLat 40.85600000

GpsLong -96.65780000

### K Record Averages

SkyViewCap 360.

AViewCap 45.

AViewAzm 0.

FBeam 0.60

WideSky 560.00 639.35 761.65 922.60 827.40

ASky 42.50 59.07 62.13 72.03 82.15

Figure 21: The items added to the file header when scattering correction inputs are applied.

If this comment is present, then K records 
are also present, and the values beneath it 
represent averages of the K records, not 
direct inputs.

If G records are present (GPS data), then 
these three lines not there, but the normal 
header entries for GPS records instead.
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either computed from location, or can be entered directly. Values that have been entered directly, 
and not computed, are marked with an asterisk (*).

SolarZen 34.5*

SolarAzm 224.*

Hint: if, for example, you wish to experiment with the affect of changing solar angle on a file that 
has GPS information to compute solar angles, you can do it from the text window in Figure 10 on 
page 20 by entering both zenith and azimuth values with asterisks following them, and clicking 
the Keep button. To undo that and go back to computed values based on latitude and longitude, 
just remove the asterisks and click Keep. This can also be done in the single file dialog (Figure 11 
on page 21 by selecting “User Entered” in the Solar Angle box.

The next six values pertain to sky condition. Note that if K records are present, then these values 
represent the average of the K records that were used in the correction, and editing these values in 
the file header will have no effect. If K records are not present, then the values are inputs, not out-
puts. FBeam is the fraction of total radiation that is direct beam in the blue (320-490 nm). 
WideSky is the reading from the 5 rings with no (or the 270) view cap, sun blocked. ASky is the 
narrow sky distribution. SkyViewCap is the size of the view cap (degrees open) used for WideSky, 
and AViewCap is the size of the view cap (degrees open) used for ASky and for your normal A and 
B measurements. AViewAzm is the view direction of view (0=looking North, 90=looking East, 
etc.) for ASky and for the normal A and B measurements.

Both WideSky and ASky have the following constraints: 
• They need to be made with an unobstructed view of the sky.
• They should be made with the same wand.
• That wand making the measurements should be using the factory calibration values. This is 

the calibration that relates one ring to another. With this calibration, all of the sensor’s rings 
will read the same in a purely isotropic environment. This (WideSky and ASky) is the one time 
in LAI-2x00 processing that the rings of the sensor are NOT treated independently, and the 
factory isotropic calibration is needed.

Making it Practical

Calculating Solar Angles
The best method of getting solar angles is to calculate them. To do that, one needs to know loca-
tion (latitude and longitude) and time (UTC). The LAI-2200C (and upgraded LAI-2200s) have a 
GPS chip, that allows all of this data to be logged along with the LAI measurements. 
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If you don’t have GPS, FV2200 allows you to specify the latitude and longitude for the files you 
wish to correct, and some time zone information. UTC comes from the average time of data in the 
file and the time zone.

Fraction Beam
The fraction of the total incident radiation that is in direct beam in the waveband seen by the LAI 
wand is best measured by that wand. Kobayashi et al made this measurement by mounting a 
downward looking wand above a reflectance panel, restricting the center ring to a narrow field of 
view, and recording the sunlit and shaded readings of the panel. Subsequent experimentation has 
shown that by simply putting a diffuser on an upward viewing sensor gives very good agreement 
(unpublished data).

A suitable diffuser made from white Plexiglas is available from LI-COR (part number 6522-117), 
and is machined to slide onto the wand over the lens and stay in place in the wind, if tipped, etc. 
Alternatives are readily found (any stiff, flat, translucent material is a candidate: paper, plastic, 
etc.), so if you lose or misplace the good diffuser in the field, you might be able to find some alter-
natives (the bottom of a paper cup, for example) to keep you going (Figure 22).

K Records
To aid in getting the sky brightness data and fraction of beam information in the field as painlessly 
as possible with a minimum of extra equipment, we developed a measurement protocol illustrated 
in Figure 23, called a 4A Sequence. The name comes from the fact that you are taking four A 
readings in a row, which will later be condensed into something called a K Record.

The first two A readings use a white diffuser. With your back to the sun, and the sun shining on the 
diffuser cap, level the sensor, and take the first A reading. Then, rotate just a bit to shade the dif-
fuser cap with the shadow of your head, and take the second A reading. (If the sun is too high to 
shade the diffuser with your head, hold the sensor with one hand and reach up and out with the 
other to shade the diffuser; you want the entire diffuser completely shaded, but not much more 
than that.) For the third A record, remove the diffuser and either shade the sensor with your head, 
or simply put a 270 view cap in place. This reading needs to have the sun blocked, but retain as 

Figure 22: Some of the options for measuring fraction beam with an LAI-2x00 wand.

6522-117 Scrap piece of white Plexiglas Paper cut from bottom of a drink-
ing cup. (Thumb required)
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wide a view of the sky as possible. The final A record in the 4A sequence is a normal A reading: 
use the view cap and view direction you are using for measurements.

Ultimately, each LAI-2200 file that is to be scatter-corrected will need to have at least one K 
record in it. This does not necessarily mean that when you are collecting data in the field, you 
need to do a 4A sequence in every file. K records to be copied (by FV2200) into other files that 
need them, so you can perform a 4A sequence somewhere in a data file (beginning, middle, end, it 
doesn’t matter), or as part of a below-canopy file if you are in two sensor mode, or accumulate a 
series of them into their own separate file. It is a simple matter with FV2200 to turn the 4A 
sequences into K records (2.4.1 Generate K records from Sequences on page 17), then copy them 
to whatever files need them (2.4.3 Import K records on page 19). When FV2200 copies K records, 
it does it based on time, and uses the closest ones available in source files to the B records in the 
destination file.

How Many K Records Needed. Sky conditions will determine how often K records (i.e. 4A 
sequences) are needed. The determining factor is how fast the fraction of beam is changing. The 
simplest case (as always) is clear blue sky. During the middle of the day, one K record per hour 
would be fine. The worst case is fast-moving scattered or broken clouds, with the sun coming and 
going. The choice in those conditions might come down only taking data (A, B, and 4A 
sequences) when the sun is between clouds, or only taking data (A and B) when the sun is 
obscured behind clouds (you know the fraction of beam is 0 then, so you so don’t need K records), 
or waiting for a better day.

Another consideration is if your measurement involves multiple view directions. In principle, you 
should have a K record for each view direction used. However, if your view azimuths are symmet-
ric about the solar azimuth (e.g. sun is South, and your views are East and West), then you would 
not need multiple K records unless there were distinctly differing cloud formations in those two 
directions. 

Other Ways to Make K records
4A sequences are not the only way to make a K record.

1. Diffuser cap, sunlit 2. Diffuser cap, shaded

3. No cap, shaded (or 270) 4. Normal A reading

Figure 23: The 4A sequence.
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3A Sequence.  If you are using the same view cap for the last two A readings, you can forego the 
wide sky view (the 3rd A of a 4 A sequence). FV2200 will use the last A reading in the sequence 
for both the wide and narrow views. This of course makes the assumption that the brightness dis-
tribution in the direction of your A readings is the same as for the entire sky.

Operational hint: For a 3A sequence, you can leave the view cap in place for all three A readings 
(unless it is quite windy); simply lay the diffuser upsidedown on the view cap to do the first two A 
readings. Orient the diffuser so the open side is toward the sun so the diffuser doesn’t self-shade. 
This is especially helpful for the larger view caps (180 and 270), since they can be troublesome to 
put on with one hand.

1A + Assumption.  If your LAI data was collected with the sun obscured by cloud, or below the 
horizon, then you already know the fraction of beam is 0. If you are also willing to make the 
assumption that the sky brightness distribution in the direction of your measurement is the same 
as for the rest of the sky, then you can forego 3A or 4A sequences entirely; FV2200 will let you 
build K records based on the normal A readings in the file and your assumption of the fraction 
beam value. This is also useful for correcting old data for the effects of actual foliage reflectance 
and transmittance.

3BA and 2BA Sequence.  Consider the following situation (LAI-2200 only): You are in multi-
sensor operation mode, with one sensor devoted to A readings, and other sensor(s) doing B read-
ings. You need to get K records from the A sensor, since that’s the only one with a suitable clear-
ing. Suppose further that the A unit is just a wand that is automatically logging A records at 
regular intervals, so there’s no chance of interrupting autologging and putting 4A sequences into a 
separate file. Can you get K records in this situation? You can if there is enough time between 
autologs (you probably need at least 30 seconds) to do a few simple steps:

When it’s time to collect data for another K record, do this:

1) Wait for an autolog to occur.
2) Push the A/B button to change to B records.
3) Remove the view cap, and put the white diffuser in place.
4) With the sun on the diffuser, press the LOG button.
5) Shade the diffuser, and press the LOG button again.
6) (Optional wide sky view). With the sensor shaded, or with a wide view cap, press LOG again. 
7) Place the normal view cap back on, and press the A/B button to change back to A records, so 
that the next autologged reading will be an A.

You are essentially doing a 4A or 3A sequence, but labelling all but the last as B records.

Useful variation: if you are skipping step 6 (i.e. doing a BBA sequence), you can avoid having to 
remove the view cap at all. Simply do steps 3 through 5 by laying the diffuser on the view cap 
upsidedown (or use an alternative diffuser - see Fraction Beam on page 39 for suggestions).

What you will end up with is a file filled with A records, with an occasional 2B or 3B sequence. 
The A record that immediately follows each 2B or 3B sequence will also be used to make the K 
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record. Thus, a 3BA (i.e. BBBA) is just like a 4A sequence, and a 2BA (i.e. BBA) is just like a 3A 
sequence.

Again, the 3BA and 2BA are usually only for above files that are otherwise full of A records.

An Example

We present an example of making a single sensor measurement complete with scattering correc-
tion. We illustrate with a data file that is included in the sample data files built-in to FV2200. This 
will let you follow along on data already taken for you.

For this example we measured a site using 8 B records, and a starting and ending A record. (Final 
A records are only useful when you have interpolation enabled; we’ll do that when we are done). 
Thus, the measurement sequence without scattering corrections would be ABBBBBBBBA. 
Because we are doing scattering corrections, we need to replace at least one of the A readings 
with a 4A sequence; we’ll replace the first, leaving us with a measurement sequence that is 
AAAABBBBBBBBA. Those first 4 readings, however, are done as shown in Figure 23 on 
page 40.

You can load this data file into FV2200 (Do File > Sample files >  ScatterExample.txt). The 
state of the file is like it just came from the field - the 4A sequence is there, but hasn’t yet been 
turned into a K record.

Step 1. You will want to add a variable named ScattCorr (The ScattCorr Variable on page 35) to 
the list of displayed items in the main view of FV2200, if it is not there already. (See 1.3 Change 
the Displayed Variables on page 6 for how to do this).

‘none’ means the scattering 
input data is not there yet.
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If you wish to view the data records, double click the File1 entry, and select the Current tab.

Step 2. Click the Scattering Tool icon to open the Scattering Correction Tool, then click the K 
Records tab. Set the values as shown. 

Once the K records are made, the Records field in the main view will show the change (Added 1 
K, ‘removed’ 3 As). 

Diffuser in sun

Diffuser in shade

Wide sky

Normal A

The view cap (if any) used for 
the 3rd A reading.

The view direction for normal 
measurements.

The view cap used for normal 
measurements.

Convert sequences to K records

Specify the file and the pattern 
to convert to K records.

Click here to make K 
records.
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Step 3. Click the Clipboard tab in the Scattering Correction Input tool, and fill in the fields as 
shown. 

The file is now corrected for scattering, and the LAI increased from 1.86 to 1.95.

One final step would be to enable interpolation of the A readings, since we have that final A record 
in the file. If you do that, following 2.2 Interpolate A Records on page 15, you will find that the 
LAI for this file changes from 1.95 to 1.94.

When the scattering correction is applied (as evidenced by the ScattCorr variable having a 
numeric value), all computed values (LAI, MTA, GAPS, etc.) reflect the scattering correction. 
The value of ScattCorr itself is the difference in leaf area index (actually, it’s the difference in the 
parameter EllipLAI, the leaf area index based on the inversion scheme of Norman and Campbell 
(1989) using the ellipsoidal representation of leaf angle. This is the computation used internally 
when iterating through the scattering correction model).

Properties for the blue (320-490 nm) wavelengths.

Our file has no G records (built-in GPS informa-
tion), so we need this section.

We can skip this, since our file uses K records.

Highlight the file(s) in the main view to send this infor-
mation to, and click here.
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Model Limitations

The scattering correction is based on a simple model, and how well it works in any particular cir-
cumstance depends on how well those circumstances conform to the assumptions of the model. A 
very fundamental assumption of the model is that the canopy is one dimensional (vertical), with 
foliage that can be clumped. The sun is above the canopy looking down, and the LAI sensor is 
below the canopy looking up. The model canopy is a good approximation to a fairly uniform, full 
cover actual canopy. But how about other settings?

Here is a key factor in how well the model will predict scattering errors: The model will fail when 
the relation between gap fraction at any particular view angle and the sunlit leaf area that is visi-
ble in that view angle differs from what would be predicted in a horizontal canopy (Figure 24). 

Figure 24: Representation of how the scattering model can fail in an isolated canopy setting. Measurements A 
and B have gap fractions PA and PB for a particular ring (top). These are mapped to an idealized canopy (bot-

tom) in a layer with the same gap fraction at that view angle. The problem in case A is that the measured sunlit 
area (and thus scattered radiation) that was measured is much greater than what the model would predict. This 
is seen by comparing the relative path lengths of sunlight through the canopy to get to the ring's view in the 

measurement vs. the scattering model. I.e. . In case B, the measured sunlit area is much smaller than 

the model would predict, since )

SA S'A<

SB S'B>

SB
SA

S’A S’B
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Another way to look at the problem presented by case A in Figure 24 is that 
unlike in the model (sun above, viewer below), the viewer and the sun are 
now effectively on the same side of the canopy. And the lower the sun is in 
the sky, the more the measurement will be dominated by sunlit leaf area, 
which the model cannot begin to predict, since it assumes the viewer is on 
the opposite side of the canopy.

Figure 24 illustrates the problem and offers a clue about how to reduce the problem. If we can 
choose a view direction that minimizes the differences between the view path lengths through the 
canopy (they determine gap fraction) and the direct beam path lengths through the canopy that 
determine sunlit leaf area, then we might minimize the model’s errors. If having the sensor look 
directly away from the sun, as in Figure 24, maximizes the problem, it suggests that viewing more 
toward the sun (the sun can’t be in the sensor’s view, of course) might reduce the problem.

This suggests the following measurement guideline for canopies with significant gaps: As much as 
possible, keep the sun in front of you, not behind you (Figure 25).

Testing the Model
Since no canopy fits the model, it is a good idea to test your measurement protocol (and scattering 
correction inputs) for each situation. A simple way to do this to pick a representative transect or 
plot and measure it (at identical locations) when the sun is obscured, such as at twilight, and com-
pare those results with the scatter-corrected results. Actually, you can scatter-correct both, but the 
data set with the sun obscured will have an FBeam value of 0. It’s best to do this sort of compari-
son under clear blue sky, as clouds introduce their own variability (1.5.4 Sky Test on page 10).

Sun

Sensor

No!

Best

Best
Avoid

Figure 25: Illustration of suggested measurement protocol for non-uniform canopies. The higher the sun is 
in the sky, however, the less important this suggestion becomes. 
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Appendix B. Three Methods for FV2200 Matching

Scattering corrections have some implications for multi-sensor operations, so read this section, 
even if you think you are familiar with multi-sensor operation.

When two or more sensors are used to collect LAI data (e.g. one sensor collects above canopy A 
records, the other below canopy B records), two things have to happen to produce final LAI val-
ues:

1) Combining. The A records and the B records have to be combined into one file. Normally, 
some of the A records are inserted into the B file based on times of the B records.
2) Matching. One of the record types (A or B) must have its values adjusted to account for calibra-
tion differences between the two wands.

While it is possible to do both combining and matching entirely on an LAI-2200 console, we 
highly recommend that you use the FV2200 software for both of these tasks instead. Here are the 
reasons:
• K records (i.e. 4A sequences, 3A sequences, etc.) should be done with a wand with factory 

calibration factors, not one matched to another sensor. FV2200 matching allows all wands to 
always use their factory calibration values. This allows any wand to be used for the K record 
precursors needed to do scattering corrections.

• Console matching is done with one snapshot reading, which is dangerous when there are 
clouds. FV2200 matching is based on as many readings as you wish to average.

• FV2200 matching is not limited to two LAI-2200 wands, like console matching is: it can be 
used for any number of wands, including old (LAI-2000) instrumentation.

• Collecting the data for FV2200 matching can be done anytime, not just at the time or place of 
data collection. This means you can collect matching data under the best sky conditions for 
matching (clear blue sky), and in a place with the best view of the sky (e.g. the roof of your 
building).

• FV2200 matching simplifies what needs to be done in the field, reducing the chances for 
errors.

• Once the relevant files are on your computer, FV2200 combining and matching can be done in 
one simple step.

There are three variations you can use to do FV2200 matching. The method you choose will 
depend on the circumstances. 

For this discussion, we will assume that there is a sensor (the A unit) that is to be used for logging 
A records in a clearing, and there is one (or more) B unit collecting below canopy B records. Note 
that either “unit” could be a) an autonomous wand, or b) an LAI-2000 or LAI-2200 console and 
wand.

The three methods listed here are named for the setting in FV2200 that you would use to do the 
match while importing records. The FV2200 import dialog (2.3 Import and Adjust A Records on 
page 15) lets you specify source files (the ones with A records), destination files (the ones with B 
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records that need corresponding A records), and - when needed - match files (files that contain 
some or all of the information on how the sensors compare, so adjustments can be made to 
imported A records).

Method 1: B / A pairs in Match
(Recommended) This method puts the match readings from both A and B units into the one spe-
cial file, known as a match file. This can be done before or after the measurements. If you are 
careful about keeping lenses cleaned, this file can be generated once and used over an extended 
period (weeks, months, etc.). When you have a calibration session, you might want to generate 
several files, one for each view cap you might use. You could name the files M45, M90, M180, for 
example, meaning they are for the 45, 90, and 180 degree view cap. 

Figure 26: Sample match data for two sensors, PCH3213 and PCH3214. There are three files for three view 
caps, and in each file several data pairs, all logged while viewing clear blue sky. Since FV2200 uses serial 
numbers when applying this data, it doesn’t matter what record types (A or B) the sensors logged. They 
could be mixed (as shown), or all A, or all B. If you are doing this with LAI-2000 format files, however, then 
the only way to identify sensors is by record type, so the A records and B records in a match file should be 
made by the same sensors as did the A and B records in source and destination files. (You can convert for-
mats, however, and avoid this constraint.)
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2.3 Import and Adjust A Records on page 15 illustrates how to do match file adjustments when 
importing A records. 

The main advantage of Match Method 1 is that it eliminates all matching-related field work at the 
time of LAI data collection. Just collect your LAI data and you’re done; all the matching work has 
already been done. (Or will be done; your calibration session could also happen after the fact.)

The remaining two match methods involve collecting matching data at the time of regular data 
collection. If the sky is cloudless, then they can work as well as Method 1.

Method 2: B (or A) in Match / A in Source
This method collects match data on-site, and creates a match file that contains only the below can-
opy sensor’s match readings; the corresponding above canopy sensor’s readings are in the above 
canopy file. The situation in which you might use this method is illustrated in Figure 27 on 
page 50: There is a clearing in which the A unit will reside, and a forest or other tall canopy in 
which one or more B units will log a series of files along transects or in plots.

Method 3: A in Dest / A in Source
This method collects match data on-site, but does not use a separate match file. Instead, each B 
file contains its own match data, in that every B file contains at least one A record that can be used 
for matching. To make this work, it must be possible for each B unit to get to the A site and take at 
least one A record for each file it creates. Figure 28 on page 51 illustrates.

A potential advantage of Method 3 is that since you have an A record logged, you can compute an 
LAI estimate in the field based on that one reading (if it is done first, or if you pick the “closest in 
time” option for using A records). That way, if disaster strikes (e.g. a bear makes off with the A 
unit), you still have some results.

Combining 2 and 3
You can also do a combination of these methods: If you use Method 3 for the first and last transect 
that you measure (with the A reading for the last transect coming at the end of the file), you can 
use those files as match files for any other below files that you create in between the first and the 
last ones. Those intermediate files would have only B records. Figure 29 on page 52 illustrates.
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Figure 27: Method 2 illustration of data collection and processing steps.

1. Set up the A sensor and get it logging at 
regular intervals in the Above file.

2. Before leaving the clearing, each B sen-
sor makes a few matching measurements 
next to the A sensor. Log these into a file 
named ‘Match’, or something to identify it as 
a match file. 

3. Each B unit goes off and collects multiple below 
canopy files. All have only B readings.

File B1
File B2

File B5File B4

File B3
4. (Optional) Upon returning to the clearing, append 
a few more readings into the Match file (or make a 
new match file), before shutting down the A unit.

5. When importing the A records, use Match 
Method 2 to adjust the readings according 
based on corresponding readings between 
the above file and the match file.
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Figure 28: Method 3 illustration of data collection and processing steps.

1. The A unit is set up and logging in a clearing. 

2. (Going out) Begin the first B file with an A record logged along-
side the Above unit. Then go do the rest of the B records along the 
transect.

3. (Coming back) File B2 with an A record logged beside the above 
unit.

4. Import A records to files B1 and B2 using 
Match Method 3.

File B1

File B2
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1. File B1 starts with an A record.
2. File B2 with no A records.
3. File B3 with no A records.
4. File B4 ends with an A record.

1.Use Method 2 for B2 and B3, with B1 
and B4 as Match files.

File B1

File B2

File B3

File B4

Data Collection

Data Analysis

2. Use Method 3 for B1 and B4.

Figure 29: Illustration of data collection and analysis using a combination of Methods 2 and 3. Files B1 and B4 
do double duty as both data files and match files.
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Appendix C: Some Protocol Suggestions for Direct Sun

General

These are based on Model Limitations on page 45.

Test the Model
Test how well the scattering corrections are working for you. A suggested test is described in Test-
ing the Model on page 46. 

Keep Some Canopy Between You and the Sun.
This is never a problem in a uniform canopy - the canopy is always overhead. However, in a can-
opy with large gaps, or wide rows, or when measuring individual crowns, you will need to avoid 
making readings with the sensor having an unobstructed view of the sunlit side of a subcanopy 
(Figure 25 on page 46). 

Working on Slopes
If you are collecting data on a significant slope, we recommend holding the sensor parallel to the 
slope, rather than level, when making A and B readings. In this case you also need to measure the 
3rd and 4th A readings of a 4A sequence also parallel to the ground. The 1st and 2nd readings (to 
get fraction beam with the white diffuser) should always be with the sensor level, however. See 
Figure 11 on page 21 for where to enter slope information in FV2200.

Single Sensor

• Make sure the sensor calibration is the factory default, and hasn’t been modified by matching 
to another sensor.

• You don’t need to do a K record for every file, unless sky conditions are very changeable. You 
can import K records from files that have them to files that need them (2.4.3 Import K records 
on page 19).

• You can intersperse K record 3A or 4A sequences and single A records. For example, a series 
of records such as AAAAB...AB...AB...AAAA would turn into KAB...AB...AB...KA.

• You might opt to keep the K’s in a separate file. Whenever you need to do another K reading, 
re-open that file (named K, for example), and append another 4A sequence (or 3A sequence, 
but be consistent) into it. 

Multiple Sensors

• Make sure ALL the sensors have their factory default calibrations. 
• Use Method 1: B / A pairs in Match on page 48 for your inter-sensor calibration scheme. Get 

the data for this once on a clear blue day, and then don’t worry about it after that. 
• If you are operating in separate sensor mode (remote above, and remote below), and there is 

only one person to do the work, then plan on doing K readings with the below sensor, putting 
them in a separate file. Later you can import A records from the above file, and import K’s 
from the K file.

• If there are enough people to dedicate someone to doing the K records, then ideally they also 
have a separate instrument (or just a wand) to dedicate to it as well. However, if the A unit has 
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to do double duty as the “K unit”, one option is to do nothing but K records (recall that a K 
record includes a normal A record): Go though a 4A or 3A sequence as frequently as you 
think is needed, or as frequently as your sanity can stand. In clear blue sky, one K record every 
10 or 15 minutes would be plenty. However, if you think you need a higher frequency of refer-
ence A records than K records, then see 3BA and 2BA Sequence on page 41 for how to do 
that. 
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